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Ključne riječi i pojmovi 

PowerPoint, prezentacija, dizajn, video bim, interaktivna prezentacija, slajd, master 

slajd, slajd šou, font, prelaz, tranzicija, animacija, multimedija, kodek, hiperlink, akciono 

dugme, štampanje, eksport 
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1 PowerPoint 

 

PowerPoint je program za izradu multimedijalnih prezentacija i dio 

je Microsoft Office paketa. 

 

 

 

 
 
 

1.1 Prezentacije i njihova primjena 

 

Prezentacija predstavlja oblik komunikacije čije su 

najznačajnije karakteristike da je: 

• javna, sinhrona i najčešće usmjerena na veći 

auditorij 

• svrhovita, organizovana, strukturirana i  

• vremenski ograničena 

PowerPoint je prije svega program koji kreira prezentaciju koja govorniku omogućava 

prikaz te prezentacije na nekom skupu, tako da se na monitoru ili platnu projektora  

prikaže niz slajdova, koji zainteresovama olakšava praćenje materije. Ovakva 

prezentacija olakšava i govorniku prikaz dajući mu mogućnost da unaprijed pripremi 

kompleksne crteže i objašnjenja, ili da onemogući da se zaboravi i previdi neka sitnica. 

 

Prezentacija koju kreiramo PowerPoint-om je zapravo niz slajdova (sličica) u koje 

umećemo tekst, slike, grafikone, zvuk  i eventualno dodajemo efekte i filmove, da bi 

dobili na dinamičnosti i zanimljivosti onoga što prezentujemo. 
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1.2 Tehnička podrška i pomagala za prikaz prezentacije 
 

Prezentacioni slajdovi se prikazuju prvenstveno na video bimu, ali mogu se koristiti i za 

izradu folija za grafoskop, 35 mm slajdove, štampanje reklamnog materijala, pa i za za 

prikazivanje na filmskom platnu. 

 

Mikrofon je obavezan dio opreme, ukoliko prezentaciju vršite u velikim  prostorijama i 

pred velikim brojem slušalaca. Najbolje je koristiti bežični mikrofon koji će vam 

omogućiti slobodno kretanje i lakše korištenje ostale opreme. 

Preporuka: Odredite optimalnu udaljenost između usta i mikrofona. 

 

Projektor omogućava multimedijalnu prezentaciju i daje mogućnost kombinovanja 

govora prezentatora s nekoliko medija, a time i mogućnost promjene ritma prezentacije, 

čime se održava stalna pažnja publike.  

Preporuka: Prilikom upotrebe projektora obavezno provjerite: 

• da se prezentacija može pokrenuti na računaru; 

• da se na zidu ili platnu ne stvara izobličena slika; 

• da svi mogu jasno vidjeti sliku; ako je potrebno zamračite prostoriju ili 

promijenite podlogu prezentacije; 

• da imate zvučnike, ukoliko prezentacija sadrži zvuk. 

 

Ukoliko imate potrebu da se krećete tokom prezentacije, koristite daljinski upravljač 

za promjenu slajdova. Ako nemate daljinski, a želite da se krećete obezbjedite asistenta 

koji će vršiti izmjenu sadržaja. 

 

Prilikom korištenja grafoskopa ili projektora često se javlja potreba naglašavanja 

pojedinih detalja prezentacije. Najbolje sredstvo za pokazivanje je laserski pokazivač 

sa crvenom tačkom. 

 

1.2.1 Mediji i pamćenja prezentacije 

Ma koliko autori i Microsoft tvrdili da su prezentacije prenosive, jedini pouzdan način 

da pokrenete prezentaciju je da ponesete svoj računar i da Vaš laptop podržava elemente 

u projekcionoj sali (da postoje drajveri koji će pokrenuti projektor, odnosno grafoskop, 

ili čak jednostavano veliki monitor), ili i da njih ponesete sa sobom. 

I kad (ako) obezbjedite prenosivost, nije sigurno da ćete uskladiti snagu vašeg računara 

sa onim koji treba da pokrene prezentaciju. Računari treba da budu apsolutno usklađeni. 

 

Napomena: Snimanje prezentacije na CD je način da prezentaciju ne demonstrirate, 

ili da je prezentujete u osakaćenoj formi. Zašto? Pa zato što i najjednostavnija izmjena 

nije moguća. 

Zato prezentaciju sem u oblaku (kome ponekad ne možete pristupiti zbog gubitka 

internet konekcije), zapamtite i na USB uređaju. 

https://mke.sveznadar.info/
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2 Pripremna faza 

 

Osnovne faze u pripremi (bilo koje, pa i PowerPoint)  prezentacije su: 

• Izbor teme i definisanje svrhe 

• Definisanje ciljne grupe 

• Prikupljanje materijala za datu temu 

• Analiziranje publike i okolnosti 

• Oblikovanje prezentacije 

• Provjera i vježbanje i konačna provjera 

 

2.1 Plan prezentacije 

Prije nego što startate sa izradom prezentacije neophodno je da obavite pripremu i 

napravite plan prezentacije. Plan prezenatcije predviđa da definišete  cilj i poruku, a 

obično se podrazumijeva definisanje sadržaja i broja strana i okvirno vrijeme trajanja 

buduće prezentacije. 

Prije samog plana trebali bi da znate šta želite postići prezentacijom; koja je njena svrha, 

njena glavna ideja, njen opšti cilj?  

 

Pored opšteg cilja trebate odrediti posebne ciljeve za svaki dio prezentacije. Time 

postižete da svaki dio vaše prezentacije ima smisao i da uvijek znate u kojem pravcu 

razvijate prezentaciju. 

Trebate moći odgovoriti (preporuka u pisanoj formi) bar na slijedeća pitanja: 

Zašto im ovo govorim – sada? 

Zašto ovo radim – sada? 

Kakav efekat želim ostvariti? 

Kakve rezultate želim postići? 

Preporučili bi da plan napravite tek nakon što obavite:  

1. Pronalaženje materijala. Proučiti što više relevantnog materijala koji je na 

raspolaganju; wikipedija i internet su dobar početak. 

2. Struktuiranje materijala. Poželjno je da se pronađeni materijal podijeli na 

logičke cjeline koje čine okvir i konture prezentacije. 

3. Pisanje opis prezentacije. Na osnovu koncepta dobijenog struktuiranjem 

materijala treba napisati prezentaciju u cjelini. 

Pošto je pretpostavka da ste ovladali Word-om, predlažemo da u Word-u napravite skicu 

buduće prezentacije.   
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2.1.1  Određivanje ključnih elemenata prezentacije 

Prezentacija treba biti odgovarajuće dužine – ni prekratka, ni preduga.  

U oblikovanju prezentacije trebalo bi da se prevashodno koncentrišete na ključne 

dijelove.  

Najčešći problem nije premalo, već previše materijala 

Obično se preporučuje da utvrdite tri (maksimalno sedam) ključne stvari koje publika 

treba saznati. 

Da bi optimizirali koje su to ključne stvari prikupljenii materijal klasifikujte na slijedeći 

način: 

• Informacije koje se moraju znati. 

• Informacije koje se trebaju znati. 

• Informacije koje je dobro znati. 
 

Kada se  izaberu informacije koje se “moraju” možete uključiti ili izostaviti ostale 

informacije. 

 

 

2.1.2 Analiziranje publike i okolnosti 

 

Dvije ključne odrednice vezane za publiku su: 

1. Da je upoznate, 

2. Da se stavite u njenu poziciju. 

Prostor u kojem će se održavati prezentacija takođe treba upoznati i, ako je oguće, 

prilagoditi svojim potrebama. Ujedno je neophodno izabrati i organizovati adekvatna 

pomoćna tehnička sredstva za izvođenje prezentacije. 
 

U pripremnoj fazi bi trebali definisati, broj i vrstu slika, ilustracija, način kretanja kroz 

prezentaciju, eventualnu upotrebu specijalnih efekata i multimedije. 

Ovi parametri se grubo govoreći definišu na osnovu dva parametra: 

• sadržaja prezentacije 

• ciljne grupe prezentacije. 

 

Ako imate više ciljnih grupa, razmislite o tome da napravite više prezentacija, pokušaj da 

se napravi univerzalna prezentacija, koju će svi razumjeti i prihvatiti, gotovo uvijek znači 

lošu prezentaciju, koja nikog ne interesuje. 

 

Za prave dizajnere pripremna faza je najvažnija, kasnije je sve stvar tehnike. 
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2.1.3 Vježba i konačna provjera 

 

Bez obzira koliko dobro pripremljena prezentacija može biti potpuno upropašteno 

lošim nastupom.  

Vještina prezentiranja se, kao i druge vještine, može naučiti. Vježbanje je sastavni dio 

tog procesa. Kontinuiranim vježbanjem i ponavljanjem izvođenje prezentacije postaje 

bolje. Uspješno provedene vježbe će vam dati samopouzdanje. 

➢ Probajte izvesti cijelu prezentaciju, u formi kako to čine glumci 

➢ Probajte prezentaciju pred ogledalom ili pred drugima. 

➢ Probajte na mjestu održavanja prezentacije (ukoliko je moguće). 

➢ Probajte kao da je publika zaista prisutna. 

 

Konačna provjera podrazumijeva provjeru prostora i opreme, slajdova prezentacije i 

vašeg izgled. Obavezno dođite prije početka prezentacije, kako bi mogli izvršiti 

potrebne provjere. 

 

 

2.1.4 Struktura prezentacije 

 

Struktura prezentacije treba biti logična.  

Univerzalno preporučena prezentacija treba imati uvod, glavni dio i zaključak: 

1. Recite im ono što namjeravate da im kažete. 

2. Objasnite to što ste najavili. 

3. Recite im ponovo ono što ste im rekli. 

 

Uvod trebao biti efektan, atraktivan i upečatljiv. I kod uvoda postoji niz preporučenih 

faza i slijedećih koraka: 

• pozdravljanje prisutnih, 

• predstavljanje (lično ili od strane nekog drugog), 

• privlačenje pažnje, 

• upoznavanje publike sa temom (najčešće se radi o navođenju ciljeva i sadržaja 

• izlaganja). 

Tako bi da privučete pažnju publike, mogli pripremiti neku zabavnu anegdotu,  

primjer, ili citat vezan za temu koju prezentujete. Može se započeti nekim nečekivanim 

gestom, ali ako je moguće ne pretjerano dramatično i patetično). 

 

U glavnom dijelu prezentacije razvijate i argumentujete glavne ideje.  

Veoma je važno razviti interakciju – treba nastojati što više uključiti publiku u 

prezentaciju, što se postiže postavljanjem pitanja koja potiču na diskusiju, ili ako tema 

došušta čak i davanjem kratkih zadataka koje publika treba pokušati rješiti. Ako ovo 

činite trebate se pripremiti šta da radite ako publika ne reaguje. 
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Zaključak prezentacije treba predstavljati sažet presjek glavnih tačaka. U zaključku ne 

treba iznositi nove informacije. Zaključak možete završiti i ponudom publici da vam 

postavi pitanja vezana za temu.  

 

Pitanja su preporučeni dio zaključka ukoliko nisu ranije korištena u glavnom dijelu 

prezentacije. 

 

 

2.1.4 Vrijeme 

Vrijeme prezentacije odnosi se na termin održavanja i trajanje prezentacije. 

Prezentaciju obavezno trebate početi u zakazano vrijeme. Kašnjenje daje negativan prvi 

utisak, a on je nerijetko presudan za uspjeh cjelokupne prezentacije. 

Na osnovu vježbe treba da znate koliko prezentacija može trajati i to bi trebali najaviti u 

uvodu. 

Bez obzira koliko vremena imate za prezentaciju, potrebno je efektivno iskoristiti to 

vrijeme, pa bi mogli da se pridržavate jednostavne formule: 

• 80-85% vremena posvetiti glavnim tačkama prezentacije, 

• preostalih 15-20% vremena podijeliti između uvoda i zaključka. 

 
 

2.2 Pravila dizajna prezentacije 

 
Postoji hiljadu pravila kako dođi do dobre prezentacije. Osnovno pravilo je da prije nego što 

pristupite izradi prezentacije ovladate tehnikom (koja će dijelom biti ovdje izložena), da 

vježbate i imate osjećaj mjere. 

Navešćemo nekoliko desetina pravila (32) bez namjere da ih naučite (pogotovo ne napamet). 

Ona su ovdje samo kao podsjetnik na koji se trebate vratiti kad napravite desetak probnih 

prezentacija. 

• Tekst je u obliku teza (a ne kompletno objašnjenje; prepričavajte tekst svojim 

riječima – parafrazirajte) 

• Čitajte tekst prezentacije samo kada ga navodite citat 

• Izbjegavajte čitave rečenice 

• Izbjegavajte animacije koje previše odvraćaju pozornost 

• Slajdovi moraju biti čitljivi 

• Upotreba najviše dvaju prelaza - između slajdova i između poglavlja 

• Ista pozadina za cijelu prezentaciju 

• Upotreba jednostavnih pozadina 

• Izbjegavajte davanje značenja različitim bojama (kolor - kodiranje, 

crveno/radost, crno/tuga nije nešto što je samo po sebi prihvatljivo) 

• Koristite jake kontrastne boje: 

https://mke.sveznadar.info/
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• Svijetla boja na tamnoj pozadini 

• Tamna boja na svijetloj pozadini 

• Prikaz 1-2 slajda po minuti prezentacije 

• Prikaz tabličnih podataka lakše se razumije na grafu 

• Poštujte gramatiku i primjenjujte rečeničnu strukturu (prvo - veliko, ostala - 

mala slova).  

• Provjerite prezentaciju tražeći: pravopisne greške, gramatičke greške i 

ponavljanje riječi 

• Koristite VELIKA SLOVA – samo za naglašavanje  
 

 

2.2.1 Vrste slova (Fonts) 

• Izbjegavajte upotrebu kompliciranih, dekorativnih fontova, jer su loše čitljivi. 

• Za naslove: Arial, Verdana, Helvetica 

• Za tekst: Arial, Times New Roman, Garamond, Palatino 

• Italic slova se teško čitaju – izbjegavajte 

• Podebljana Bold ili Shadow slova – za naglašavanje 

• Premalena slova, sve manje od 20 pt je teško čitljivo 

• za sporedne teze – 28 

• za glavne teze – 32 

• za naslove - 44 

 
 

2.3.2 Pravilo 6/6/6 

Šest riječi po redu 

Šest redova po slajdu 

Šest slajdova teksta uzastopno (poslije toga obavezno bi bio neki slajd sa grafikom i 

animacijama) 

 

2.2.3 Pravilo 10/20/30 

Ne više od 10 slajdova po prezentaciji (pretpostavka je da je potrebno dva minuta za 

objašnjenje sadržaja slajda) 

Približno 20 minuta trajanja prezentacije 

Ostatak vremena za pitanja i raspravu nakon izlaganja. Prezentacije koja traje više od 30 

minuta rijetko kad može da održi interes publike. 

Bez detaljne analize daćemo još nekoliko savjeta: 

• Slike za prezentaciju birajte (i kreirajte)  u (iz) .jpg formatu. 

• Za ekranski prikaz slike treba da budu maksimalno iste rezolucije kao i ekran 

(monitor) preporuka maksimalno 800 x 600 za rezoluciju 1024 x 768 (odnosno cca 

2/3 ekranske rezolucije) 

https://mke.sveznadar.info/
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• Za prikaz preko projektora slike treba da su u rezoluciji projektora 

• Audio fajlove pripremite u .wav formatu, a ukoliko su veći  u .midi, ili .mp3  formatu 

(ali u tom slučaju obavezno provjerite audio kodek1). 

• ako koristite video zapis provjerite koji video kodek imate instalisan, ili koristite 

Windows avi fajl 

 

 

2.2.4 Početni slajd prezentacije 

 

Početni slajd PowerPoint prezentacije treba sadržavati naslov prezentacije, instituciju 

ispred koje se vrši prezentacija, vaše ime i prezime, te datum i mjesto prezentiranja.  

Na posljednjem slajdu poželjno je izraziti zahvalnost publici i navesti kontakt 

informacije. 
 

 

2.2.5 Animacije i prelaz  

 

Preporučuje se korištenje iste vrste animacije i prelaza u cijeloj prezentaciji. Korištenje 

različitih animacija i prelaza može uticati na pažnju auditorija i odvratiti ih od slušanja 

prezentacije.  

Ukoliko koristite jednu istu animaciju kroz cijelu prezentaciju olakšavate da se publika 

fokusira na sam sadržaj.  

Izuzetak od ove preporuke je ukoliko imate dužu prezentaciju pa promjenom animacije 

želite da “razdrmate” publiku i skrenete joj pažnju na sadržaj slajda koji želite naglasiti. 
 

  

 
1 Kratica od koder/dekoder odnosi se na program koji vrši konverziju u ovom slučaju iz jednog u 

drugi audio format. 
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3 Start PowerPoint-a 
 

PowerPoint pokreće se kao i svi Windows programi dvoklik na ikonu PowerPoint-a ili 

preko dugmeta Start. Pokretanjem se dobije prozor kao na Slici 1. 

 

Slika 1 Mogući izgled startnog prozora PowerPoint-a 

Postoji mogućnost izbora prazne prezentacije, Blank Presentation, nekog od ponuđenih 

šablona, ili potraga za nekim od šablona na internetu.  

Izbor Blank Presentation daje prazna radnu površinu što  omogućava da u potpunosti 

samostalno dizajnirate slajd koji želite da prikažete. 
 

 

3.1 Osnovni elementi prozora za izradu prezentacije 

 

Kad pogledate osnovni prozor PowerPoint-a vidjećete da se sastoji od standardnih 

elemenata Office prozora.  

U centralnom dijelu nalazi se okvir slajda sa izabranim slajdom, a ispod njega okvir za 

bilješke (Notes), gdje se mogu unositi eventualni komentari. Komentari se ne prikazuju 

u prezentaciji i služe kreatoru prezentacije kao podsjetnik. 

Lijevo se nalazi pregled slajdova koji se nalaze unutar prezentacije, a izabrani slajd (čiji 

sadržaj je prikazan u centralnom dijelu) je istaknut (uokviren). 

Status Bar – prikazuje poziciju slajda i tip dizajna u PowerPoint-u.  

Sa ostalim dijelovima radnog okruženja upoznaćemo se kroz praktičan rad. 
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Slika 2 Standardno radno okruženje PowerPoint-a 

 

3.2 Podešavanje radnog okruženja  
 

Moguće izvršiti personalizaciju tj. definisanje radnog okruženja po sopstvenim 

potrebama korištenjem menija View i izborom željenih opcija. Dopušta izbor različitog 

pogleda na prezentaciju kao na Slici 3. 

 

Slika 3 Izbor prikaza radnog okruženja PowerPoint-a 

PowerPoint nudi nekoliko modova prezentacijskog prikaza: 
1. Normalno (Normal) – običan prikaz koji je predefinisan i najčešće se koristi 

2. Prikaz konture (Outline View) prikazuje prezentaciju kao nacrt sastavljen od 

naslova i glavnog teksta sa svakog slajda. Svaki naslov se pojavljuje na lijevoj strani 

okna. Grafički objekti se pojavljuju samo kao male oznake na ikoni slajda u prikazu 

Outline.  

3. Razvrstavač slajdova (Slide Sorter View) prikazuje skice svih slajdova kako biste ih 

lakše mogli razmjestiti. 

4. Stranica s napomenama (Note Pages) pruža veliki okvir za pisanje bilježaka za vaš 

govor. Bilješke možete unositi i u prikazu Normal, no stranica za bilješke pruža vam 

više prostora. 

5. Dijaprojekcija (Reading View/Slide Show) prikaz prezentacije preko cijelog ekrana 

onako kako će je vidjeti publika. 
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Prezentacijske prikaze mijenjamo koristeći dugmad na statusnoj traci ili na kartici Prikaz 

(View) 

4 Osnovni pojmovi i osnovne operacije 

 

Datoteka prezentacije/Prezentacija: Datoteka koja se pamti  na disku i koja sadrži sve 

slajdove, govornikov podsjetnik, skice, itd. koji čine prezentaciju. 

Dokument u PowerPoint-u se naziva prezentacije i ima ekstenziju pptx. Dokument se 

sastoji od slajdova. Dokument se pamti  na disku i sadrži sve slajdove, govornikov 

podsjetnik, skice, itd.  

 

Slajd (Slide): Pojedinačan prikaz u toku prikazivanja slajdova. Predstavlja jednu stranicu 

na koju unosimo različite podatke odnosno predmete. 

 

Predmet/objekt: Bilo koji  element u slajdu, npr. crtež, tekst, tabele, zvučni zapisi ili 

video klipovi.  

 

Ako slajd shvatimo kao osnovni samosvojni element: entitet, predmet možemo 

shvatiti kao elementarni element koji gradi taj entitet. 

 

Slajd šou (Slide Show): Prikaz serije slajdova koji se pojavljuju jedan za drugim. Može 

se kontrolisati ručno ili automatski. 

 

Prelaz: Specijalni efekti koji se koriste za  spajanje slajdova tokom slajd šoua. 

 

Animacija: Animirani efekt koji se primjenjuje objekt. 
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4.1 Postavljanje scene dizajn pozadine i „master“ slajda 

 

Matrica slajdova (Slide Master)  za koju se često koristi naziv Glavni slajd služi za 

dizajniranje šablona.  

 

Slika 4 Definisanje glavnog (Master) slajda 
 

Master Slide je dizajn šablon ili tema dizajna. Glavni slajd određuje ukupan izgled i 

postavku svih slajdova u prezentaciji. Ako se na njega stavi logotip, promeni pismo ili 

postavka boja šablona, doda tekst, datum, broj slajda i slično to će biti vidljivo na svim 

slajdovima. Po analogiji sa pozorištem odgovara postavci scene na kojoj se odvija 

predstava-prezentacija. 

Master Slide može koristiti (i preporučuje se da se koriste bar kao podloga i polazna 

osnova) neke od predefinisanih tema koje su ugrađene u PowerPoint.  

 

Uređivanje Slide Mastera se obavlja 

iz menija View – Master izabrati Slide 

Master, napraviti sve promjene koje 

želimo na svim slajdovima na isti način 

kao i na običnom slajdu.  

Moguće je definisati (urediti - formatirati) boju pozadine slajda izborom pune boje Solid fill, 

prelaza Gradient, ili gotovog uzorka Patern.  

Ako želimo da se promjene primjene na svim slajdovima biramo Apply to All, a 

poništavamo sa Reset Background. Na Slici 5 pokazano je kako se definiše tema pozadine 

(Themes) iz standardne ponude tema PowerPoint. 
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Slika 5 Izbor teme prezentacije 

Nakon izvršenih promjena na Slide Masteru odaberemo Close i nastavljamo sa izradom 

prezentacije koja će koristiti Master slajd kao podlogu. 

Osim što skraćuje vrijeme uređivanja i dizajniranja, Slide Master zaključava svaki element, 

okvir, sliku i slično u normalnom pregledu. Zbog toga korisnik ne može pomaknuti pojedine 

stvari kada je u normalnom pregledu niti ih tako slučajno obrisati. Jedine stvari koje se mogu 

modificirati u normalnom pregledu, a da su svejedno postavljene u Slide Masteru, su 

rezervisana mjesta. 

 
 

4.1.1 Rezervisana mjesta 
 

Rezervirana mjesta (eng. placeholders), su prethodno kreirana vrsta kontejnera koji 

zadržavaju lokaciju, veličinu i vrstu fonta, boju, veličinu slike i slično.  

 

Slika 6 Prikaz izgleda rezervisanih mjesta 
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Rezervisana mjesta se koriste u matrici slajdova kao indikatori za unos određenog medija ili 

teksta i dopušteno ih je mijenjati, odnosno unositi u njih predviđene stvari u normalnom 

pregledu.  

Postoji nekoliko vrsta rezerviranih mjesta koja dopuštaju unos korisniku:  

1. Tekstualna  

2. Slikovna  

3. Tablelarna 

4. Rezervirana mjesta za dijagrame  

5. Rezervisana mjesta za grafove 

Rezervisana mjesta predefinisano dolaze u formi obliku pravougla, mogu se kombinovati s 

geometrijskim likovima ukoliko se želi stvoriti mjesto nekog drugog oblika.  

Željeni oblik, npr. krug, se postavi iznad rezervisanog mjesta te se označe oba elementa. 

 U paleti Format > Merge Shapes > funkcija intersect će zadržati samo dio gdje se oba 

elementa dodiruju, a ostatak će nestati.  

Na taj se nači mogu dobiti zanimljivi oblici i dizajnirati različite prezentacije.   

Rezervirana mjesta se u normalnom pregledu prepoznaju se po iscrtkanoj liniji i ikoni usred 

okvira koja, kada je kliknuta, omogućuje odabir medija.  

Rezervisano mjesto će se uvijek pojavljivati ispred slike ili objekta. Samo drugo rezervirano 

mjesto može doći ispred.  

Rezervirana se mjesta ne mogu grupisati, ali se mogu obrisati čak i ako se korisnik ne nalazi 

u master slajd matrici. 

 

4.2 Dodavanje teksta na stranicu 

 

Tekst unosite u predviđene okvire za naslov i okvire za unos teksta. Za unošenje teksta 

u prezentaciju kliknite na slajd u koji želite unijeti tekst, a potom na okvir predviđen za 

tekst. Okvir koji se vidi prije i prilikom unošenja teksta završetkom uređivanja teksta 

nestaje i ne vidi se kod prikaza slajdova na ekranu niti kod štampanja slajdova.  

Kada završite unos teksta, kliknite mišem izvan okvira.  

Ako želite, povlačite kursore za izbor okvira za tekst, kako biste mu promijenili veličinu. 

 

Pored unosa teksta u predviđene okvire (u rezervisana mjesta) tekst na slajd možete 

staviti i okvire za tekst koje ćete sami napraviti. Da biste napravili okvir za tekst, slijedite 

ove korake: 

1. Kliknite na Insert>Text Box. 

2. Kliknite na slajd na kojem želite da se pojavi tekst. Pojaviće se mali okvir za tekst 

koji se po potrebi može proširiti, dok budete unosili tekst. 
 

➢ Za uređivanje samo jedne riječi kliknite dva puta na riječ. 

➢ Za uređivanje paragrafa (pasusa) kliknite tri puta unutar pasusa. 

➢ Tekst se briše tasterima Delete i Backspace. 
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➢ Za umetanje novog teksta, pokazivač miša postavite na mjesto na kojem želite 

➢ umetnuti tekst, kliknite i upišite tekst. 

➢ Na tekstu možete koristiti opcije Cut, Copy i Paste. 

➢ Za uređivanje razmaka označite tekst i koristite Format>Line Spacing. 

➢ Za promjenu fonta i oblikovanje riječi označite tekst i koristite Format>Font. 

➢ Za poravnanje označite tekst i koristite Format>Alignment. 

 

 

4.2.1 Dodavanje i formatiranje tekstualnih objekata 

 

Šablon Title Slide sadrži rezervisana polja za tekst, za naslov i podnaslov. Tekst može 

da se kuca ili kopira iz nekog dokumenta (koga smo ranije pripremili). Rezervisanim 

mjestima možete mijenjati veličinu, premještati ih i mijenjati ih koristeći razlike bordure 

i boje. 

 

Unos teksta u naslov 

1. Kliknite u polje za tekst Title. Pojaviće se široka siva okvirna linija oko polja za 

tekst, što ukazuje da je aktivirano. 

2. Ukucajte naslov. 

Unos teksta kao komentar slajda 

1. Izaberete Insert/Text Box. 

2. Pokazivač miša se transformiše u produženu strelicu kojom markiramo mjesto gdje 

želimo da bude ispisan tekst. 

3. Pojavi se okvir kao na slici. 

4. Izaberemo font koji želimo koristiti. 

5. Izvršimo unos teksta. 

Kasnije je moguće izvršiti promjenu pozicije teksta (pomjeramo ga kao objekat). Kad se 

mišem pozicioniramo iznad teksta pojavi se sidro što je znak da je selektovan objekat i 

onda možemo da ga pomjerimo na novu poziciju. 

 

 

 

4.2.2 Automatsko prilagođavanje teksta 

Predefinisano PowerPoint mijenja veličinu teksta tako da izborom  Text Box iz 

kartice Insert nacrta rezervisani prostor. Ako unesete više teksta nego što može stati u 

rezervisano mjesto PowerPoint će smanjiti veličinu fonta (8 pt je najmanja moguća 

veličina). Ako nekoliko riječi teksta naslova pređe u sljedeći red, tekst se smanjuje za 

jednu jedinicu veličine fonta da stane u jedan red. 

Automatsko prilagođavanje možete uključiti i isključiti. Postavka automatskog 

prilagođavanja teksta tijela primjenjuje se i na bilješke (Notes). 
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PowerPoint ima mogućnost rada sa WordArt, SmartArt, Shapes komandama i 

komandama za izradu tabela Table i Chart, koje su dostupne iz menija Insert. Sa njima 

se radi na sličan način koji je opisan u Word-u.  

Isto tako je moguće traženje  i zamjena teksta se slično kao kod Word-a komandama  

 i  iz menija Home. 
 

 

4.3 Dodavanje sljedećeg slajda 

Klikom na komandu  New Slide u meniju - traci Home dodaje se novi slajd 

ispod selektovanog. 

 

4.4 Prelazak sa slajda na slajd 

Prelaz slajda vizualni je efekt koji se pojavljuje prilikom prelaska s jednog slajda na 

drugi tokom prezentacije. Moguće je upravljati brzinom, dodavati zvuk i prilagođavati 

izgled efekata prelaza. 

Sa slajda na slajd možete prelaziti upotrebom tastera PageUp i Page Down ili klikom na 

slajd koji se nalazi u (lijevom) oknu Pregled slajdova.  

 

4.4.1 Definisanje tranzicije prelaza sa slajda na slajd 

Prelaz sa slajda na slajd (eng. Transition) može da bude izveden upotrebom nekoliko 

predefinisanih efekata, koji simuliraju najosnovnije efekte montaže: prelaz sa slajda na 

slajd je ekvivalentan prelazu sa kadra na kadar kod filma. 

 

 

Slika 7 Izbor efekata tranzicije 

Predefinisano je prelaz bez efekata: eng. No transition. Pošto svaka promjena (unutar 

Effect options menija) podržava nekoliko podopcija: eksperimentišite i  izaberite onaj 

prelaz koji vam se čini primjeren sadržaju i dizajnu. 

Oznaka da postoji tranzicija je zvjezdica ispod broja slajda. 

Sve što moramo napraviti je kliknuti na sličicu prelaza i PowerPoint će nam prikazati 

pregled mogućih tranzicija.  Kako bi vidjeli više mogućih prijelaza, kliknimo na strelicu 

za više .  
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Ukoliko želite dodati isti prijelaz svim slajdovima, jednostavno selektovati sve slajdove 

koristeći  Ctrl+A.  

Ukoliko imate zvučnu karticu imate mogućnost da prelaz sa jednog slajda na drugi 

indicirate i zvučnim efektima .  

Ovu opciju koristite samo kad želite nešto naglasiti i privući pažnju slušalaca. 

 
 

4.5 Brisanje slajdova 

Brisanje jednog ili više slajdova radi se tako što ih prvo selektujete, a zatim: 

pritisne desni taster miša i u kontekst meniju odaberete naredbu Delete slide 

, ili pritisnete taster Delete na tastaturi.  

 

 

4.6 Prikaz slajd šoa 

 

 
Slika 8 Izbor efekata 

 

Slajd šou se može se kontrolisati ručno ili automatski. Može još da se pokrene:  

• Iz  naslovne linije  klikom na ikonu  od početka 

• Iz statusne linije klikom na ikonu  od trenutno selektovanog slajda 

• Pozivom F5 i koristeći PageUp taster prelazite sa slajda na slajd. 
 

4.6.1 Automatsko pokretanje prezentacije 

Ako prezentaciju programa PowerPoint šaljete kolegama ili prijateljima ili ako je 

izvodite u štandu ili kiosku, možda želite da korisnici odmah gledaju prezentaciju kao 

dijaprojekciju umjesto da vide slajdove u načinu uređivanja. Evo procedure kako da 

izaberete tu opciju (vidi Sliku 9): 

Otvorite prezentaciju koju želite automatizirati u PowerPointu. 

Odaberite karticu " Slide Show ". 

Odaberite " Postavi dijaprojekciju ". 

Odaberite opciju " Pregledano na kiosku (cijeli ekran) ". 
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Slika 9 Izbor automatskog pokretanja prikaza 

 

4.6.2 Kreiranje višestrukog prikaza slajd šoa 

Postoji mogućnost da u okviru jedne prezentacije izaberete više prikaza. To se čini 

definisanjem korisničkog prikaza Define Custom Show iz menija Slide Show. 

 

Slika 10 Koraci definisanje više slajd šou prezentacija iz jedne prezentacije 

Kasnije ćete imati mogućnost da koristeći kao osnov jednu datoteku vršite prezentacije za 

različite nivoe publike, ili za različita vremenska ograničenja. 
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5 Dodavanje netekstualnih objekata 

 

Slajd pored teksta može sadržati i netekstualne objekte od kojih se najčešće koriste grafički 

(slike, oblici…). Grafički objekti se ubacuju izborom kartice Insert. 

Obavezujuća naredba je umetenja slika (teško je i zamisliti prezentaciju bez slika). 

 
 

Slika 11 

Pogledaj na Slici 9 šta sadrži meni Insert u grupi komandi Images, na paleti kartice, nalaze 

se komande:  

Picture – umetanje slike iz nekog fajla; Clip Art – umetanje slike iz Microsoft-ove galerije; 

Screenshot; PhotoAlbum. 

 

Na ovoj kartici se još nalaze komande za iscrtavanje oblika (Shapes), tabela Table), 

umetanje TextBox-a, zaglavlja i podnožja stranice (Header & Footer), WordArt-a, datuma 

i vremena (Date & Time). 

 

Provježbaj i ubaci nekoliko slika sa različitih destinacija. 

Uredi slike i prilagodi ih formatu slajda. 
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Postavi različite okvire oko slike. Pomoć izbor stilova (vidi Sliku 12): 

 
Slika 12 

 

 

5.1 Umetanje multimedijalnih efekata i fajlova 
 

U prezentaciju možete ubaciti i razne multimedijalne efekte: zvukove, melodije, govor, 

filmke sekvence. Ove komande se nalaze u grupi Media kartice Insert. 

 
 

Slika 13 Ilustracija procedure umetanje multimedijalnog fajla 

 
Indikacija da se na slajdu nalazi (da je ubačen) video klip je navigator pomoću kojeg 

može da se vrši pregled i pokretanje filma. 
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Indikacija da na slajdu nalazi zvučni fajl je  ikona, koja takođe ima navigator: 

  
koji omogućava podešavanje i reprodukciju zvučnog fajla. 

 

 

5.2 Interaktivna prezentacija (kreiranje hiperveza) 
 

U prezentacije se mogu unijeti i veze prema drugim datotekama na računaru ili veb 

stranicama na internetu. Veze se mogu postaviti na tekst, slike ili druge objekte, ali i na 

akciona dugmad koja možemo sami kreirati dajući im željeni izgled.  

 

Veza se postavlja tako što se na slajdu označi objekat na koji se postavlja veza i zatim 

klikne na dugme Hyperlink koje se nalazi na Insert kartici. 

Moguće je da ponudu kreiranja dobijete kad akon selekcije izvršite desni klik pa iz 

kontekst menija izabere  . 

 

Slika 14 Umetanje hiperveza 
 

Da bi kreirali vezu ka drugom slajdu u prezentaciji treba da izabreze Place in this 

Document iz liste slajdova odaberite slajd prema kome treba biti postavljena veza i 

potvrdite kreiranje veze klikom na dugme OK.  
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Na sličan način moće se izvršiti povezivanje sa bilo kojim fajlom 

koji se nalazi na računaru.  

Ukoliko je potrebno postaviti vezu ka određenom veb-mjestu, 

umesto odabira datoteke na računaru, u polju Adress potrebno je 

uneti njegovu URL adresu. 

Postoji mogućnost kreiranje veze ka e-mail adresi izborom E-mail Address i unosom 

željene elektronske adrese u polju Address, koje se pojavi kad izaberete ovu opciju. 

 

5.3 Kreiranje akcione dugmadi 

 

Jedan od načina da se objekti unutar slajda povežu sa drugim slajdom ili dokumentom 

jeste kreiranje akcijskih dugmadi. Klikom na takvo dugme postavljena veza vas odvodi 

na željenu lokaciju (otvara novi dokument, ide na veb stranicu ili prelazi na drugi slajd 

kako je opisano u predhodnoj lekciji). 
 

 

 
Slika 15 Izbor akcijske dugmadi 
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Za kreiranje akcionih dugmadi primjenjuje se sljedeća procedura na Insert kartici 

kliknite na Shapes dugme i odaberite jedno od ponuđenih dugmadi sa dna padajuće liste, 

vidi Sliku 15. 

 

Kad se postavi dugme na željeno mesto na slajdu pojavi se Action Settings dialog 

prozor i izborom Mouse Click karticu u Action on click grupi, odabere se Hyperlink 

to:, što otvara padajuću listu (Slika 16) iz koje se bira jedna od ponuđenih opcija. 

 

 
Slika 16 Izbor akcije koju će pokrenuti akciono dugme hiperlink 

 

Ako se čekira Play Sound prilikom klika na akciono dugme čuće se  izabrani zvuk. 

Izgled akcionog dugmeta se mijenja na isti način kao i izgled bilo kog Shapes oblika. 
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6 Animacija objekata slajda Slide Animation 

 

Postoje mogućnost da definišete način pojavljivanja pojedinih elemenata slajda izborom 

iz trake Animations. 

 

Slika 17 Izbor animacije objekta 

 

Animacije  se  dodaju  tako  da  iz  menija Slide  Show izaberemo Custom Animation 

S desne strane pojaviće se task pane – Custom Animation. 

 Obrati pažnju na vremenski dijagram i način okidanja (pokretanja, vremensko 

„trigerovanje“) i strata pojavljivanja i dužine trajanja pojedine animacije prikazan u 

animacionm panelu, koji se setuje i pokazuje vremenski dijagram kako je ilustrovano na 

Slici 19. 

 
Slika 18 Poziv i prikaz  Animacijskog panela 
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Animacija teksta (naslova ili pojedinih komentara) je privlačna opcija, ali odvlači 

pažnju od drugih detalja. Zato imajte mjeru ako koristite ovaj efekat. 
 

Analiziraj kreiranje scene i rad sa efektima animacije objekta korišćenjem Animation 

Pane opcija na pojedinim objektima na Slici 19. 

 

 
Slika 19 Definisanje starta i trajanja animacije 

 

Koristeći dugmad  možete preliminarno vidjeti kakav 

ste efekat izabrali. 
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7 Štampanje prezentacije 

 

Moguće je odštampati cijelu prezentaciju (slajdove, struktury, stranice komentara-

bilježaka  (Notes)) ili možete odštampati samo određene slajdove, brošure, stranice ili 

bilježaka i stranice struktura.  

Poziv Print rutine za štampanje obavlja se iz menija File i dio opcija koje su nabrojane 

pokazan je na Slici 20. 

 
 

Slika 20 Podešavanje opcija štampe 

 
Napomena: 
Opcija štampanja daje i mogućnost virtuelne štampe tako da se fajl, u ovom slučaju 
prezentacija, odštampa, odnosno konvertuje, u drugi fajl. Ovu mogućnost ćemo djelom 
razmotriti nešto kasnije, a zasad ćemo razmotriti neke od mogućnosti „stvarne“ štampe na 
štampaču  
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7.1 Osnovne opcije štampanja 

 

Osnovne postavke štampe date su na slici 21 i one su: 

1. Štampanje kopija - Izaberite broj kopija koje želite da odštampate. 

2. U odeljku Printer (Štampač ) izaberite odgovarajući štampač, ako je na 

računaru ili mreži instalirano više od jednog štampača, klikom na strelicu 

padajuće na odabranom štampaču i izaberete. 

3. U odeljku Postavke , opcija za ispis svih slajdova je podrazumevana 

postavka. Kliknite strelicu spusti da napravite alternativni izbor. 

4. Slajdovi sa cijelom stranom su podrazumjevana opcija. Kliknite strelicu 

spusti da napravite alternativni izbor.  

5. Collated - Stranice će se sakupljati kao stranice 1,2,3; 1,2,3; 1,2,3 i tako 

dalje, osim ako ne odaberete da odštampate neispravne stranice kao 1,1,1; 

2,2,2; 3,3,3 i tako dalje. 

6. Boja - Podrazumevani izbor je da se štampa u boji. Ako je izabrani štampač 

štampač u boji, slajdovi će štampati u boji. U suprotnom slajdovi će se 

štampati na crno-bielom štampaču u sivoj boji.  

 

 
 

Slika 21 Podešavanje opcija štampe 
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7.2 Štampanje u formi brošure 

Zbog veličine fontova poželjno je da više slajdova rasporedimo na jednu stranicu za 

štampu. Poželjno je da da napravimo raspored za štampu i pogledamo kako će izgledati 

korišćenjem Handout Master koji se poziva iz kartice View vidi Sliku 22. 

Tu se eventuano definišu dodatni elementi ispisa (kao datum, zaglavlje, numeracija)  
 

 

Slika 22 Definisanje elemenata ispisa brošure sa Handout Master 

 

 

Slika 23 Poziv preliminarnog prikaza brošure prije samog štampanja 
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7.3 Štampanje zabilješki i komentara 

Prezentacijski prikaz zabilješki i komentara  omogućuje unos zabilješki i komentara koji 

se neće projektovati i prikazivati prilikom same prezentacije. 

 

Slika 24 Unos komentara iz Normal (lijevo) i Notes (desno) prikaza  

Osnovna namjena zabilješki je  
• da autoru posluži kao podsjetnik na neke detalje koje će kasnije eventualno razraditi i 

ugraditi u prezentaciju 

• da onome ko vrši prezentaciju omogući da ne zaboravi da spomene neke detalje koji su važni, 

a nisu sadržani na slajdu 

Očigledno je zašto oni nisu i ne treba da budu vidljivi publici, međutim poželjno je da 

ih autor kada štampa prezentaciju on često želi da ih vidi odštampane. 

To se postiže uključivanjem opcije za štampu strana napomena (Notes Pages), na sličan 

način kako je objašnjeno kod štampe brošura. 

 

Slika 25 Ilustracija načina izbora štampanja komentara  
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8. Dodatne mogućnosti 

 

8.1 Konvertovanje prezentacije u druge formate 

 

Ponekad se pod terminom „Export“ podrazumjeva smještanje fajla na drugu lokaciju. 

Ako jednostavno želite da "izvezete" datoteku (u njenom trenutnom .pptx formatu) na 

drugi sistem za pamćenje ili uređaj, kao što je fleš disk, priključite taj fleš disk u računar 

i koristite File > Save As (ili Save a Copy) da biste spremite na tu novu lokaciju. 

 

Prezentaciju možete konvertovati u  različite formate. 

Najjednostavni će te to uraditi korištenjem opcije Save As i izborom novog formata. 

 

 

Slika 26 Mogućnost pamćenje u različitim formatima 

 

Naredba Save as PDF  će PowerPoint prezentaciju konvertovati u PDF format. U ovom 

slučaju će svaki slajd biti prikazan na jednoj stranici.  

Slično je i sa ostalim formatima. 

Umjesto SaveAs možete pozvati meni Export kao na slici dole. Primjetićete da je ponuda 

slična samo nešto malo drugačije (preglednije) organizovana. 
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Slika 27 Mogućnost eksporta u različite formate 

Bilo koji način da izaberete poslije toga u novootvorenom dokumentu možete obaviti 

dodatna podešavanja izgleda dokumenta. Podešavanja zavise od formata.  

Ako već imate potrebu da izvršite eksport, vjerovatno znate kakko da podesite izgled 

dokumenta. To se obavlja na sličan način kao podešavanje parametara za štampu. 

 

 

Slika 28 Eksport prezentacije u Word 
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8.2 Korišćenje PP za izradu filma 

 

Kao moderan alat za izradu prezentacija PP ima dosta solidnu podršu i mogućnost da 

klasičnu prezentaciju u formi slajdova konvertujete u film. Procedura je krajnje 

jednostavana:  

Kreiramo slajd.  
1. U slajd ubacite film ili samo animirane objekte koji čine kadar filma. 

 

 

Slika 29 Primjer slajda koji  sadrži animirane objekte koji se pokreću u različito 

vrijeme, definisano u Animacionom panelu 

 

Slika 30 Primjer slajda koji  sadrži tri filmska isječka na različitim pozicijama koji se pokreću 

u različito vrijeme, a zajedno čine jedan kadar kreiran iz ovog slajda 

Možete i da koristite kombinaciju „umetnuti“- insertovan film i animirani objekti. 

Dodate objekte koje želite da se pojave zajedno (prije/poslije ili istovremeno sa filmom). 
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2. Izvršite vremensko prilagođenje korišćenjem i zadavanjem vremena 

pojavljivanja i nestanka objekata na sceni. 

3. Kad završite sa montažom i rasporedom objekata pogledate prelimenarni 

izgled kadra. 

4. Ako ste zadovoljni u meniju File birate Export a potom Create Video 

5. zaberete željenu rezoluciju (standardno Computer&HD) 

6. Izaberete željenu dužinu trajanja filma (predefinisano je 5 sekundi, a scena 

može da traje i 1 sat.) 

7. Klik na Create Video (Slika 31) 

 

Slika 31 Procedura poziva za kreiranje filma – konvertovanje pptx u avi 

 

8. Date ime datoteke koja sadrži video i definišete lokaciju gdje želite da je 

smjestite . 

 

I to je to, klikom na Save biće kreiran Windows Media film. 

 

Ako vaša prezentacija sadrži više slajdova podržana je i mogućnost da kreirate film koji 

će koristite pojedinačne slajdove kao kadrove filma. Procedura je ista kao i za 

pojedinačni slajd. „Jedini“ problem je što svi kadrovi isto traju (vidi Sliku 31), a to se 

može rješiti korištenjem nekog jednostavnog programa za montažu. 
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Vježbe i samostalan rad 

 

Zadatak 1: Podsjeti se Word-a i provježbaj mogućnosti WordArt u PowerPoint-u 

koristeći svoje ime u naslovu prezentacije. 

 

Zadatak 2: Poveži dva slajda koristeći tranziciju 

 

Zadatak 3: Kreiraj akciono dugme tako da „ispliva“ (Fly in) u sredini slajda. 

 

Zadatak 4: Obogati prezentaciju zvukom (Audio) 

 

Zadatak 5: Ubaci video zapis u donji desni ugao slajda, postavi okvir oko njega i 

definiši mu veličinu  (ns primjer 640 x 480) 

 
 

 

Pitanje: Kada i kako se koristi hiperlink? 

 

Zadatak 6: koristeći slajd kreiraj film 

 

Predlog  za samostalan rad: 

 

➢ Napravi ličnu prezentaciju, gdje ćeš predstaviti sebe. 

 

➢ Napravi prezentaciju gdje ćeš nas upoznati sa ulicom u kojoj živiš. 
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